
InfoRapid Search & Replace
InfoRapid Search & Replace is one of the most powerful text retrieval programs currently 
available for Windows 95, 98 and NT 4.0. With it's built-in converters, it's excellently suitable for 
searching and previewing HTML and RTF documents. In pure text files, the found passages can
be replaced after the search is over. The program has a preview window, in which the hits are 
marked highlighted. A special feature is, that InfoRapid can use WinWord converters to search 
WinWord, Excel, Lotus, WordPerfect and other documents and to preview them in their original 
layout.

InfoRapid Search & Replace is freeware and may be copied, distributed and used for private 
purposes without any limitations. Installing and using the freeware version on a 
commercially used computer is absolutely prohibited. In order to use the program 
commercially, you need one license (50 DM) for every user.

InfoRapid Search & Replace searches your PC for files and key words and presents the search 
results in a clear list with text excerpts and hypertext links. After the search is done, the found 
passages can be replaced - not only in ASCII, but also in binary files.

The advantages of InfoRapid Search & Replace lie in the diverse search options and in the 
simple operation and handiness. A click on a hypertext link in the search result list opens the 
corresponding file in the text viewer and jumps to the marked passage. Another click, this time 
with the right mouse button, brings you back to the search result list. With the function keys F5 
and F6 you can browse through the search result list entry by entry, without shifting between file
viewer and search result list every time. If you discover a word you would look further on, a 
double click on it suffices to take it as new search expression and start a new search. Up to 999 
search result pages and search parameters can be stored in a database, from where they can 
be recalled via a register.

The main features are:
· HTML and RTF files can be searched and previewed by using the internal text converters.
· If you have installed MS-Office 95 or newer, then InfoRapid can use the WinWord converters

to search and preview the most common file formats.
· Up to 999 search result pages and search parameters can be stored in a database, from 

where they can be recalled via a register.
· Several search expressions can be combined by using boolean operators (AND, OR, NOT, 

NEAR X CHARACTERS).
· The program supports a phonetic search after similarly sounding words.
· Regular expressions are supported.
· The search expressions can be divided in sub expressions, which can be replaced 

separately to support context sensitive replacement.
· Several file masks can be combined (*.TXT | *.DOC | *.searches files with the extensions 

TXT, DOC and RTF).
· Several directory names can be combined (C:\ | D:\ | E:\ searches the drives C:, D: and E:).
· Text and image files can be watched in the built in file viewer. It supports the graphic formats

BMP, JPEG, WMF and EMF, GIF is locked because of the UNISYS patent. In text files, the 
hits are marked highlighted.
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Searching for files
First, you have to select the register card SEARCH in the search / replace dialog. Next, enter 
the names of the files you want to search for in the input field FILE MASK. Similarly like under 
DOS, you can use the place holders * and ? in order to look for a whole group of files. While the
question mark ? stands for a maximum of one character, the star * corresponds to any number 
of characters. You can also combine file masks and file names using the character | (Alt + 
0124). For example, use the file mask *.TXT | *.DOC to search for files with the extension TXT 
or DOC. On the right hand side of the input control is a button, which shows a popup menu. You
can use it to enter the place holders ?, * and | comfortably.

After it, you must enter the names of the directories, that should be searched, in the input field 
DIRECTORY. You can combine them using the character | (Alt + 0124). For example, use the 
file mask C:\ | D:\ | E:\ to search the directories C:, D: and E:. Click the button right beside the 
combo box to open a directory browse dialog, with which you can select a directory on your 
computer comfortably. You can also open the dialog consecutively several times in order to 
combine several directories.

In the end you have to check, if the subdirectories of the selected directory should also be 
searched.

Important: Make sure that the input field SEARCH EXPRESSION is empty, because this 
distinguishes between a text search and a search after files.

If all data is correct, you can start searching. Make sure that the register card SEARCH is 
active, since the behavior of the START button depends on the active page and starts either 
searching or replacing.

After you have pressed the START button, InfoRapid Search & Replace switches automatically 
to the search result view. During the search process, an entry is inserted for each found file. The
search can be canceled anytime by pressing STOP or ESC.

After the search is finished, you can browse the search result list with the function keys F5 and 
F6. You can also jump directly to a file by clicking on the corresponding hypertext link with the 
left mouse button. A click with the right mouse button or pressing the ESC key returns you to the
search result list.



Searching for text
First you have to select the register card SEARCH in the search / replace dialog. Enter the 
desired search expression in the field SEARCH EXPRESSION. The two buttons OPERATOR 
and CHARACTERS right beside the input field show popup menus, with which you can insert 
operators and special characters into the search expression.

In the next step, you must enter the names of the files, in which you want to search, into the 
input field FILE MASK. Similarly like under DOS, you can use the place holders * and ? in order 
to look for a whole group of files. While the question mark ? stands for a maximum of one 
character, the star * corresponds to any number of characters. You can also combine file masks 
and file names using the character | (Alt + 0124). For example, use the file mask *.TXT | *.DOC 
to search for files with the extension TXT or DOC. The button right beside the combo box opens
a file dialog, in which you can select the files directly (multiple selection by pressing the CTRL or
SHIFT key). Right beside is a second button, which you can use to enter the place holders *, ? 
and | comfortably.

After it, you must enter the names of the directories, that should be searched, in the input field 
DIRECTORY. You can combine them using the character | (Alt + 0124). For example, use the 
file mask C:\ | D:\ | E:\ to search the directories C:, D: and E:. Click the button right beside the 
combo box to open a directory browse dialog, with which you can select a directory on your 
computer comfortably. You can also open the dialog consecutively several times in order to 
combine several directories.

As next, you must select the search method, that should be used. You can choose between a 
standard search, with which regular expressions are possible and a phonetic search, which 
finds also similarly sounding words. In the end you have to check if you only want to search for 
whole words, if the search should be case sensitive or not and if the subdirectories of the given 
directory should be also searched.

If all data is correct, you can start searching. Make sure that the register card SEARCH is 
active, since the behavior of the START button depends on the active page and starts either 
searching or replacing.

After you have pressed the START button, InfoRapid Search & Replace switches automatically 
to the search result view. During the search process, an entry is inserted for each found 
passage. The search can be canceled anytime by pressing STOP or ESC.

If you use external converters, then the first search process can last several minutes. That is 
because the documents must be converted into pure text files, before they can be searched by 
InfoRapid. In order to speed up the search process, InfoRapid uses a cache, in which converted
text files are stored. All following search processes access the cached documents directly and 
last only a few seconds. If a document has changed, the cached copy is updated automatically 
with the next search.

After the search is finished, you can browse the search result list entry by entry with the function
keys F5 and F6. With the function keys F7 and F8, you can go to the next or previous file in the 
search result list. You can also jump directly to a passage by clicking on the corresponding 
hypertext link with the left mouse button. A click with the right mouse button or pressing the ESC
key returns you to the search result list.





Replacing text in files
The text replacing procedure is similar to the text searching procedure, with the difference that 
the found passages are replaced by the text given on the register card REPLACE in the end.

First, you must enter the search expression, that should be replaced later in the documents, on 
the register card SEARCH. It's best to choose the standard search method, because with the 
phonetic search, the found passages usually don't agree with the given search expression and 
so you can hardly predict, which passages are really replaced at all.

After it, you switch to the register card REPLACE and enter the text, by which the found 
passages should be replaced. With it, you can not only replace the whole search expression, it's
also possible to replace a single sub expression.

If all data is correct, you can start searching. Make sure that the register card REPLACE is 
active, since the behavior of the START button depends on the active page and starts either 
searching or replacing.

After you have pressed the START button, InfoRapid Search & Replace switches automatically 
to the search result view and shows all found passages. The search can be canceled anytime 
by pressing STOP or ESC. The file corresponding to the first found passage is opened and a 
dialog pops up, in which you can check, if the passage should be replaced or not. You can also 
choose to replace all following passages without questioning. After a passage is replaced, the 
corresponding hypertext link in the search result list is marked in a different color.

If you have canceled the replace process and would like to continue at another position, you 
must only click with the left mouse button on the corresponding hypertext link. A click with the 
right mouse button or pressing the ESC key returns you to the search result list.

Important: Please replace text only in pure text files. In binary files like WinWord 
documents, replacing text changes the file structure and makes the document useless in 
most cases. Text will be replaced at the moment you confirm the replacement. Later on, 
you have no possibility to undo the replacement. Replacing is done on a binary level, 
that means that the file is really cut before the passage, the new text is inserted and the 
remainders are attached behind again. That has the advantage, that no format characters
are lost.



The search / replace dialog
By using the search / replace dialog, you can search an expression in different files and replace 
the found passages afterwards with new text.

The search / replace dialog consists of five register cards: SEARCH, REPLACE, 
CONVERTERS, OPTIONS and EXAMPLES.

· The register card SEARCH
Here you can enter the search expression, the start directory, the names of the files that 
should be searched and the search method. Furthermore you can check, if you want to 
search case sensitive, if word fragments or only whole words are found and if you also want 
to search the subdirectories of the start directory.

· The register card REPLACE
On the register page REPLACE, you can enter the text, by which the found passages should
be replaced. If the search expression consists of several parts or sub expressions, you can 
select the part, that is replaced later, here.

· The register card CONVERTERS
Here, you can choose if the internal converters should be used for searching HTML and RTF
files and if the installed WinWord converters are used for searching and previewing 
documents.

· The register card OPTIONS
Here, you can enter the font which is used in the preview window. You can also select, if the 
found files are opened immediately in their registered application or if the integrated file 
viewer is used. Furthermore, you can choose to open the most recently used search result 
database automatically, when the program is started and you can enter the maximum 
number of search result pages, that are stored in the database.

· The register card EXAMPLES
It contains examples for complex search expressions

At the lower edge of the dialog you find the two buttons START and STOP.

· The button START
Starts depending on the active register card searching or replacing.

· The button STOP
Cancels the search / replace process.



The register card SEARCH
SEARCH EXPRESSION
Here you can enter the text, after which you want to search for. The last 50 used search 
expressions are stored and can be recalled by opening the combo box. A search expression can
consist of boolean operators (AND, OR, NOT, NEAR X CHARACTERS) and can also contain 
regular expressions, if you use the standard search method.

OPERATOR
Opens a popup menu, which can be used to select one of the possible operators and insert it at 
the current cursor position into the search expression. If you have marked one or more 
characters in the search expression, they are overwritten by the operator.

CHARACTER
Opens a popup menu, which can be used to insert frequently used expressions and special 
characters into the search expression. If you have marked one or more characters in the search
expression, then they are overwritten by the inserted expression.

FILE MASK
Here you can enter the names of the files, which should be searched. The last 25 used file 
masks are stored and can be recalled by opening the combo box. Similarly like under DOS, you 
can use the place holders * and ? in order to look for a whole group of files. While the question 
mark ? stands for a maximum of one character, the star * corresponds to any number of 
characters. You can also combine file masks and file names using the character | (Alt + 0124). 
For example, use the file mask *.TXT | *.DOC to search for files with the extension TXT or DOC.
The button right beside the combo box opens a file dialog, in which you can select the files 
directly (multiple selection by pressing the CTRL or SHIFT key). Right beside is a second 
button, which you can use to enter the place holders *, ? and | comfortably.

DIRECTORY
Here you can enter the names of the directories, that should be searched. The last 25 used 
directory names are stored and can be recalled by opening the combo box. Several directory 
names can be combined by using the character | (Alt + 0124). For example, use the file mask 
C:\ | D:\ | E:\ to search the directories C:, D: and E:. Click the button right beside the combo box
to open a directory browse dialog, with which you can select a directory on your computer 
comfortably. You can also open the dialog consecutively several times in order to combine 
several directories.

SEARCH METHOD
Here you can select between a standard search and a phonetic search. With the standard 
search, the search result matches exactly the search expression, while the phonetic search 
returns also similarly sounding words. The phonetic search is NOT case sensitive and supports 
only boolean operators, but no regular expressions.

MATCH WHOLE WORDS
If the input field is checked, only whole words but no word fragments are found.

CASE SENSITIVE
Determines, if the standard search should distinguish between small and capital letters.

WITH SUBDIRECTORIES



Check this input field, if the directories contain further subdirectories, that should also be 
searched.



The register card REPLACE
SEARCH FOR
Shows the search expression from the register card SEARCH once again.

REPLACE WITH
Here you can enter the text, by which the found passages should be replaced.

REPLACE
A search expression can consist of maximum nine sub expressions, which are surrounded by a 
pair of round brackets (). The sub expressions are numbered from left to right beginning with 1. 
Here you can distinguish, which sub expression should be replaced.



The register card CONVERTERS
USE INTERNAL CONVERTERS FOR HTML AND RTF FILES
If this option is activated, then HTML files are translated into a readable form (formatting tags 
are removed) before they are searched and previewed. For the first time, the internal HTML 
converter is clearly faster than the external one, but the internal converter shows the file only as 
pure text without formatings. On the other hand, RTF files are searched and previewed as 
formated text, the RTF tags are interpreted and faded out.

USE EXTERNAL CONVERTERS
External converters are filters, which are installed together with WinWord on your PC and which 
could be shared by InfoRapid. The list box below shows the converters, that are installed on 
your PC. All documents, whose extension fits to an external converter, can be searched and 
displayed in its original layout.

If you use external converters, then the first search process can last several minutes. That is 
because the documents must be converted into pure text files, before they can be searched by 
InfoRapid. In order to speed up the search process, InfoRapid uses a cache, in which converted
text files are stored. All following search processes access the cached documents directly and 
last only a few seconds. If a document has changed, the cached copy is updated automatically 
with the next search.



The register card OPTIONS
FONT FILE VIEWER
The FONT button opens a font selection dialog, with which you can adjust the font for displaying
pure text documents in the preview window.

OPEN FILES IN THE REGISTERED APPLICATION
If the input field is checked, a click on a hypertext link doesn't open the file in the file viewer, but 
in the registered application which is associated to the file extension.

LOAD THE MOST RECENTLY USED DATABASE WHEN THE PROGRAM IS STARTED
If this option is active, then the most recently used search result database is opened 
automatically, when the program is started.

MAX N SEARCH RESULT PAGES PER DATABASE
Here you can enter the maximum number of search result pages, that are stored in the 
database. When the maximum number is reached, the new search result replaces the oldest 
one at the right hand side of the register.



Examples for search expressions
And-Operator &
Uwe&Udo&Jan searches for files, which contain the names Uwe, Udo and Jan
Uwe&20Jan searches for files, in which Uwe is separated by max. 20 characters from 

Jan

Not-Operator !
!Uwe searches for files, which do not contain the name Uwe
Uwe&!(Udo&Jan) searches for files, which contain the name Uwe, but not the names Udo 

and Jan
Uwe&20!Jan searches for files, in which Uwe is separated by more than 20 characters 

from Jan or in which the name Uwe, but not Jan is contained

Or-Operator |
Uwe|Jan searches for files, which contain either the name Uwe or Jan or both of 

them
Uwe&(Udo|Jan) searches for files, which contain the name Uwe and one ore both of the 

names Udo or Jan
Uwe&!(Udo|Jan) searches for files, which contain the name Uwe, but none of the words Udo 

or Jan

Aufzählungen
[A-C]D matches AD, BD or CD
[ABC]D matches AD, BD or CD
[A-CZ]D matches AD, BD, CD or ZD
M[AE][IY]ER matches MAIER, MAYER, MEIER or MEYER

Wiederholungen
AB*C matches AC, ABC, ABBC, ABBBC etc.
(AB)*C matches C, ABC, ABABC, ABABABC etc.
(AB)+C matches ABC, ABABC, ABABABC etc.
(AB)?C matches C and ABC.
(AB){3} matches ABABAB 
(AB){2,} matches ABAB, ABABAB, ABABABAB etc.
(AB){2,3} matches ABAB and ABABAB.

Unterausdrücke wiederholen
(AB)(CD)\1 matches ABCDAB
(AB)(CD)\2 matches ABCDCD



Search expressions
The simplest realization of a search expression consists only of a single word. If you search 
many files, this could lead to a crowd of search results. To refine the search, InfoRapid Search 
and Replace supports the boolean operators AND &, Or | and Not !. For example if the search 
for the word "car" is too coarse, you can use the search expression car&20red to restrict the 
search results to those passages, in which the distance between the words "car" and "red" is 
less than 20 characters.

Sometimes it is also useful to define sub expressions by using the brackets (). The expression 
(car|bike)&20red first marks all files, which contain the words "car" or "bike". The so found 
passages were examined, if the word "red" occurs in a distance of maximum 20 characters to 
the words "car" or "bike". If so, they are taken over to the search result list.

With the search method STANDARD you can also use regular expressions to search for text 
patterns. A regular expression is a sequence of characters and operators, which may match 
different words. So the expression [ae] in the regular expression M[ae][iy]er causes InfoRapid to
find all words, whose first character is a "M" and whose second character is either a "a" or a "e".
The next expression [iy] stands for a "i" or a "y". At the end, the regular expression M[ae][iy]er 
matches the names Mayer, Meyer, Maier and Meier.

The following search Operators can be used with the search method STANDARD and 
PHONETIC:

& And
(Expression_1)&(Expression_2)
Finds only those files, that contain both Expression_1 and Expression_2.

&n Near n characters
(Expression_1)&n(Expression_2)
Finds only those files, in which Expression_1 stands max. n characters away from 
Expression_2.

! Not
!Expression
Finds only those files, which do not contain the given expression.

With the standard search, you can also use the following operators:

| Or
(Expression_1)|( Expression_2)
Finds only those files, which contain either Expression_1 or Expression_2 or both of 
them.

. Any character
Matches all passage, which contain any character at the position of the point.

[ ] Character range
[c1-c2]



A character range is an enumeration of characters, that are enclosed in square brackets.
It can be realized by listing the characters (i.e. the characters a, b and e [abe]), by 
specifying a range of characters (i.e. all characters from A to Z [A-Z]) or by a combination
of both (i.e. [abeA-Z0-9]). Passages are found if they contain any character of the 
character range at this position in the search expression.

^ Line start
^Expression
A passage is found, if it contains the expression at the beginning of the line.

$ Line end
Expression$
A passage is found, if it contains the expression at the end of a line.

\< Word start
\<Expression
A passage is found, if it contains the given expression at the beginning of a word.

>\ Word end
Expression\>
A passage is found, if it contains the given expression at the end of a word.

() Sub expression
Expression_1(Sub expression)Expression_2
The following repetition operators always refer to the leading character. If they should 
refer to more than one character, these characters must be combined to a sub 
expression by using round brackets.

\n Repeat sub expression n
(Sub expression)\n
All sub expressions are numbered consecutively from left to right beginning with 1. If a 
sub expression should be repeated at another position in the search expression, it is 
enough to use it's number instead of writing it completely down a second time. A 
passage is found, if it contains the nth sub expression at the position of \n.

* Zero or more matches
(sub expression)*
A passage is found, if it contains the given sub expression zero or more times in 
sequence.

+ One or more matches
(sub expression)+
A passage is found, if it contains the given sub expression one or more times in 
sequence.

? Zero or one match
(sub expression)?
A passage is found, if it contains the given sub expression zero or one times.



{n} Exactly n matches
(sub expression){n}
A passage is found, if it contains the given sub expression exactly n times in sequence.

{n,m} Min. n, max. m matches
(sub expression){n,m}
A passage is found, if it contains the given sub expression at least n and at most m times
in sequence.

The special characters | . [ ] ( ) { } ^ $ \ * + ? are reserved for operators. If you want to search for
them, you must put a backslash \ in front.



File menu commands
The File menu offers the following commands:

New Creates a new database for search results.

Open Opens a database with search results.

Save As Saves the search result database with a new filename.

Reorganize Rearranges the entries in the search result database, so that they 
use less storage. Frequently used databases should be 
reorganized once per month, in order to minimize the storage 
consumption.

Page Setup Changes the page layout settings.

Print Prints the active document.

Most recently 
used files

Opens the selected search result database.

Exit Exits InfoRapid Search & Replace.



Edit menu commands
The Edit menu offers the following commands:

Copy Copies data from the document to the clipboard.

Select All Selects the entire document.

Delete Page Removes the current search result page from the database.

Rename Page Changes the name of the search result page in the register.

Shift Page Left Shifts the current search result page by one position to the 
left in the register.

Shift Page Right Shifts the current search result page by one position to the 
right in the register.

Open in registered 
Application

Opens the file, which is currently displayed in the preview 
window, in its registered application.

Browse menu commands
The Browse menu offers the following commands:

Previous Search Result Shows the previous hit in the search result list.

Next Search Result Shows the next hit in the search result list.

Previous File Shows the previous file with hits in the search result list.

Next File Shows the next file with hits in the search result list.



Cache menu commands
If external converters are used, InfoRapid stores the converted text documents compressed in 
the cache file seCache.tmp on the hard disk. This cache prevents InfoRapid from converting the
documents every time they are searched and makes the search process much faster.

The Cache menu offers the following commands:

Reorganize Removes all obsolete documents from the cache.

Delete Deletes the content of the cache.

View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status bar Shows or hides the status bar.

Window menu commands
The window menu offers the following commands, which enable you, to arrange multiple views 
in the application window:

Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.

Window 1, 2, ... Goes to the specified window.

Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application:

Help Topics Offers you an index to topics on which you can get help.

The InfoRapid Cardfile 
System

Shows you a short description of the InfoRapid cardfile 
system, a powerful document management system for 
Windows 95, 98 and NT 4.0.

License Aggrement Shows you the license agreement for InfoRapid Search & 
Replace.

Order Full Version Shows you the order form for the full version of InfoRapid 
Search & Replace. It may be printed with the command 
Print in the File menu.



Register Shows the registration dialog, with which you can upgrade 
the freeware version to the full version.

About InfoRapid 
Search & Replace

Shows general information about InfoRapid Search & 
Replace.

New command (File menu)
Use this command to create a new search result database. It can be stored on the disk 
afterwards by choosing the command Save As from the file menu.



Open command (File menu)
Use this command to show the file open dialog and load a selected search result database.



Save As command (File menu)
Use this command to save the current search result database with a new filename on the disk. 
New search results are stored automatically in the database, so you don't need to call Save As 
every time you execute the search process.



Reorganize command (File menu)
Use this command to rearrange the entries in the search result database, so that they need less
storage. Frequently used databases should be reorganized once per month, in order to 
minimize the storage consumption.



Page Setup command (File menu)
Use this command to set the page layout for printed documents. This command presents the 
Page Setup Dialog Box, where you may specify the page format, orientation and margins.



Print command (File menu)
Use this command to print a document. This command presents a Print Dialog Box, where you 
may specify the range of pages to be printed, the number of copies, the destination printer, and 
other printer setup options.

Shortcuts

Mouse:
Keys: Ctrl+P



Most Recently Used Files command (File menu)
This part of the file menu displays the names of the most recently used search result databases.
You can choose one of them and open it quickly, without invoking the file open dialog.



Exit command (File menu)
Use this command to end your InfoRapid Search & Replace session. You can also use the 
Close command on the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard. This command is unavailable it 
there is on data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: Ctrl+C



Select All command (Edit menu)
Use this command to select the whole text at once.

Shortcuts
Keys: Ctrl+A



Delete Page command (Edit menu)
Use this command to remove the current search result page from the database.

Shortcuts
Keys: Ctrl+Del



Rename Page command (Edit menu)
Use this command to change the name of the search result page in the register.

Shortcuts
Mouse: Double click on the tab in the register



Shift Page Left command (Edit menu)
Use this command to shift the current search result page by one position to the left in the 
register.

Shortcuts
Keys: Ctrl+L



Shift Page Right command (Edit menu)
Use this command to shift the current search result page by one position to the right in the 
register.

Shortcuts
Keys: Ctrl+R



Open in registered Application command (Edit menu)
Use this command to open the file, which is currently displayed in the preview window, in its 
registered application. This command is only available if the preview window is active.

If the file extension isn't currently registered, you can do this using the Windows Explorer. Use 
the command Options in the View menu and switch to the register card File Types.

Shortcuts
Toolbar:

Keys: F9



Previous Search Result command (Browse menu)
Use this command to browse back to the previous hit in the search result list.

Shortcuts
Toolbar:

Keys: F5



Next Search Result command (Browse menu)
Use this command to browse forward to the next hit in the search result list.

Shortcuts
Toolbar:

Keys: F6



Previous File command (Browse menu)
Use this command to browse back to the previous file with hits in the search result list.

Shortcuts
Toolbar:

Keys: F7



Next File command (Browse menu)
Use this command to browse forward to the next file with hits in the search result list.

Shortcuts
Toolbar:

Keys: F8



Reorganize command (Cache menu)
Use this command to remove all obsolete documents from the cache.

The cache is a temporary storage, in which the converted and compressed text documents are 
stored. It prevents InfoRapid from converting documents every time from scratch, when a 
search with external filters is performed.



Delete command (Cache menu)
Use this command to delete the content of the cache.

The cache is a temporary storage, in which the converted and compressed text documents are 
stored. It prevents InfoRapid from converting documents every time from scratch, when a 
search with external filters is performed.



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in InfoRapid Search & Replace. A check mark appears next to the menu 
item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The Toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provieds quick mouse access to many tools used in InfoRapid Search & Replace.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT,V,T).

Click To

Start searching

Stop searching

Browse to the previous hit in the search result list

Browse to the next hit in the search result list

Browse to the previous file with hits in the search result list

Browse to the next file with hits in the search result list

Open the file which is currently displayed in the preview window in its registered 
application

Print the active document

Show the help index



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. A 
check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the InfoRapid Search & Replace Window. To display
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus. This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them. If after viewing the description of 
the toolbar button command you wish not to execute the command, then release the mouse 
button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down

NUM The Num Lock key is latched down

SCRL The Scroll Lock key is latched down



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion.



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)
Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)
Use this command to arrange multiple opened windows side by side.



Arrange Icons command (Window menu)
Use this command to arrange the icons for minimized windows at the bottom of the main 
window. If there is an open document window at the bottom of the main window, then some or 
all of the icons may not be visible because they will be underneath this document window.



Window 1, 2, ... (Window menu)
InfoRapid Search & Replace displays a list of currently open document windows at the bottom 
of the Window menu. A check mark appears in front of the document name of the active 
window. Choose a document from this list to make its window active.



Help Topics command (Help menu)
Use this command to display the opening screen of Help. From the opening screen, you can 
jump to step-by-step instructions for using InfoRapid Search & Replace and various types of 
reference information.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



License Agreement command (Help menu)
Use this command to display the license agreements for InfoRapid Search & Replace.



Order Full Version (Help menu)
Displays the Order Form for the full version of InfoRapid Search & Replace. It can be printed by 
using the command Print in the File menu.
The full version of InfoRapid Search & Replace contains no advertising banners, but is identical 
with the freeware version otherwise. You need the full version, if you want to install or use the 
program on a commercially used PC.



Order Form for the full version of InfoRapid Search & Replace
The full version doesn't show the advertising banner at the top of the search result view, but is identical with the 
freeware version otherwise. You need the full version, if you want to install or use the program on a commercially 
used PC. After your order arrived, you will receive a license document with your personal license number. With this 
license number, you can upgrade the freeware version of InfoRapid Search & Replace 3.0 and the next two updates 
to the full version. To do that, you just have to enter the license number and your address (the same that you included
in your order form) into the register dialog. The register dialog is located in the HELP menu under REGISTER.

Please send the completed order form to:

Ingo Straub Phone: +49-(0)7161-582151
- Softwareentwicklung - Fax: +49-(0)7161-582152
Schützenhof 2
D-73116 Wäschenbeuren
Germany

Order
 
I / we order:                    

____ license(s) of InfoRapid Search & Replace 3.0 (single price DM 50)

Total price: __________ DM

Method of payment:

(    ) Cash

(    ) American Express        (    ) EUROCARD / MasterCard        (    ) Visa 

Card number: _______________________________    Expiry Date: ____________

Card owner: _______________________________________________________

Address: _______________________________________________________

Shipping address:

Company: ___________________________________________________________

Name: ___________________________________________________________

Street: ___________________________________________________________

Zip Code, City:___________________________________________________________

Country: ___________________________________________________________

Date: _________________    Signature: ________________________________



The InfoRapid Cardfile System command (Help Menu)
Use this command to display a short description of the InfoRapid cardfile system, a powerful 
document management program.



The Register command (Help Menu)
Use this command to upgrade the freeware version of InfoRapid Search & Replace to the full 
version by entering your license number and address.



The About InfoRapid Search & Replace command (Help Menu)
Use this command to display general information about InfoRapid Search & Replace, like the 
authors address and phone number.



Print Dialog Box
The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection. Choose the Setup option to change the 
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to produce. 



Print Progress Dialog
The Printing dialog box is shown during the time that InfoRapid Search & Replace is sending 
output to the printer. The page number indicates the progress of the printing

To abort printing, choose Cancel.



Print Setup Dialog Box
The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You install 
printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup Dialog Box
The following options allow you to choose the page layout for printed documents. The top part 
of the dialog shows a preview of the page layout.
Paper Size

Choose the size of the paper or envelope you want to use.
Paper Source

Choose, where the paper you want to use is located in the printer. Different printer models 
support different paper sources, such as the upper tray, envelope feed, and manual feed.

Orientation
Choose, how the document is positioned on the page (Portrait or Landscape).

Margins
Sets the printing area of the page. The margins you set here are never printed on.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
<<YourApp>>.



Context Help command 

Use the Context Help command to obtain help on some portion of <<YourApp>>.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the <<YourApp>> window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the document.    You can use the 
mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to 

the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> determines
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the 
document Control menu closes only one window at a time.    You can close all windows at once 
with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the main window or a dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




